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1. Introduction (brief description of previous series)

The program ! called after the spectrometer “LISE” 2) has been developed in GANIL (Caen, France) to calculate the
transmission and yields of fragments produced and collected in an achromatic spectrometer. This code allows one to simulate an
experiment, beginning with the parameters of the reaction mechanism and ending with the registration of products selected by a
spectrometer. The program allows one to quickly optimize the parameters of the spectrometer before or during the experiment. It
also makes it possible to estimate and work in conditions of maximum output of the studied reaction products and their
unambiguous identification.

Wedge and Wien filter selections are also included in the program. In-built Energy loss, Time-of-Flight, Position, Angular,
Charge, Cross-Section distribution plots and dE-E, dE-TOF and Z-A/Q two-dimensional plots allow to visualize the results of
the program calculations.

The application of transport integrals ) lies at the basis of the program's fast calculations for estimating the temporal evolution
of phase-space distributions.

Recently, within the framework of the Dubna-GANIL collaboration, the program has undergone a number of serious changes
and has been adapted to the environment of "Windows":

¢ Being adapted to the 32-bit operating system “Windows,” the program has received an improved interface with which the
user gets all the capabilities of the given operating system (work in several windows, printer drivers, etc.);

¢ The concept of a “dead” layer of a target has been incorporated (that is very important for work with thick targets
producing light exotic nuclei);

e There is now an opportunity to choose the parameterization of fragmentation cross-sections ) and model the charge
distributions of ions ©);

¢ A number of the graphic subroutines have been changed, while some discrepancies have been corrected;

¢ A number of utilities for taking into account optimum values (target thickness, beam energy, magnetic rigidity) have been
added for the given spectrometer parameters;

¢ In-built information support helps the user quickly become familiar with the program;

¢ In-built database of nuclides (Mass excess, Binding energy, B-decay energy, Son, S2p, Qo> Sn» Sp» T1/2) 7:8) has been
added. It is possible to see the transmission of a given isotope, its characteristics, and its energy after the second dipole by
clicking on an isotope of interest in the table of nuclides with the right mouse button;

e The optical parameters of the spectrometer are entered as transport matrices ) that are more convenient. Initial angular,
spatial, and energy beam emittances are used;

e The new dipole after the Wien filter of velocities has been added (see §2. Dipole “D6).
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A more detailed description of the program, as well as all information about changes and new versions of the program, can be
found at the WWW reference: http://http:"//lise.nscl.msu.edu.html.

It is possible to obtain this program and the latest MS-DOS version using FTP at the address below (user: anonymous):

e 192.93.218.174 (at Caen);
e 159.93.20.89 (at Dubna).

You can send all your comments and remarks to the address indicated in the program.
2. Dipole “D6” after the Wien Filter

The dipole “D6” is placed on the turning platform in a vertical plane behind the Wien Filter. The dipole radius is

determined as R =Lm / 0, where 0 is the platform turning angle. The angle may be varied from 0 up to 23 degrees. This dipole
(denoted as DSMW in Fig.1) serves as the fourth selection on the mass and charge of the nucleus (A/Q). Selection by this dipole,
as with the Wien filter, is performed in the vertical plane.
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Fig.1
2.1. Angle of platform

The platform turning angle is calculated from the optical conditions and, as much as possible, compensates the filter velocity
dispersion so as to obtain only A/Q dispersion at the focal point after the turning dipole. The Wien filter optical structure
assumes that six focusing conditions must be fulfilled to achieve the best matching at the detection location. With the addition of
the turning dipole D6, these conditions must be preserved. To find the turning angle, it is necessary to solve the following
equation (given by R.Anne) arising from the optical conditions:

cos(@) - Dy + R -sin(@) - DS — R+ (1 - cos(@)) -

» [1]
Lf - Dp % -sin(@) + Lf - cos(f)- DSy — Lf -sin(f) = 0

where Dr is the dispersion [mm/%] from Wien-filter calculations, DSF is the angular dispersion [mrad/%], R is the radius of the
dipole, and Lfis the distance (see Fig.1) from the dipole to the final focal point (L = a + Lm + Lf =2 meters (default), where Lm =
0.8m and Lf'= 0.8m). The solution of the above equation, assuming a negligible contribution of DSF, is

8-Dr-Lm

—Im+ |Im*+—EF
B Im+ Lf

@ =

[ ] [2]
rad
2 ) DF

2.2. Image shift
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The image shift of nuclei in the final focal plane can be roughly determined in the following way:

shiftpp = shififjer + shifips , [3]

where
Sk!ﬁﬁifer =4 filter L » 4]
Vo
shiftpg = Dpg A5p 5)
Bp

Diijger 1s the filter dispersion [mm/%] and Dpgis the dipole dispersion [mm/%].

Using equation

A
Bp =0 — L’ [6]
Q J1-8
we find that
aBp . A(A/Q) (‘Bi
ABp(A/Q.8) _ HA/Q) L
Ep Bp Bp
and then
ABp(A/0B) _ MAIQ), 88
Bp AIQ  -(1-6")
Taking into account that the sum
AG A@ oy
—962- - +¢-Dﬁm [9]
Bps (1-Bs) ﬁﬁmr

is close to O (in the case of combined operation, Bpg = B fiiter must hold), one can estimate the image shift as

Bt = AA4/Q).

o _~~_ =7.D 10
4/ Dos 10

or, in other words, only the A/Q selection takes place.
Some possible combinations are considered in the program :

* Dpg =0 (the dipole is absent)

* Dfijrer = 0 (the velocity filter is absent)

® Dpg # 0, Dfijrer # 0, Dfijter # Dpg (it means that the angle of platform turning is not correct)
* Bp2#Bpps

2.3. Image size

The image size (distribution) defined in the program LISE is the result of the convolution of two distributions Py and Py :
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B =F @R, I
where

1. Py - The image in the vertical focal plane before the Wien filter, multiplied by the vertical magnification (y/y) of the filter-

dipole system.
2. Psy - the contribution of the momentum distribution due to dispersion in the final focal plane, which can be determined
as

_ PM - Bp,

By = Dy, [12]

£a

where PM is the momentum distribution of a nucleus before the Wien filter in 7- m, Dfp is the total dispersion of the filter-
dipole system ("fd-system") [mm/%], Bp » is the magnetic rigidity of the second dipole.

Repeating all the steps as in the previous section, it is possible to conclude that the use of the "fd-system" assumes that Pgy

vanishes because as it was mentioned before the sum (equation 9) is close to 0 and the value A (A/Q) for an isotope relative to
itself is equal to 0. It means that the final Y-image will be narrower, thus providing a better resolution than in the simple case of

the velocity filter only. Hence the second distribution is taken as the & -function in order to obtain ]—7; = F, asa result of

convolution.

After this consideration it is possible to compare the “fd-system” with an ordinary velocity filter (see Table 1) : application of the
“fd-system” provides better results for smaller object size and wider momentum distribution.

Table 1.
Spectrometer SISSI + SISSI + LISE LISE2000
degrader in LISE || degrader in ALPHA

‘ Y-object size, mm ‘ 0.2 ‘ 0.2 ‘ 1.5 ‘ 1.5
| magnification (Y/Y) 1 | 15.91 | 12.18 | 4.26 | 3.14
| magnification (Y/Y)2 | 0.43 | 3.44 | 0.43 | 0.60
‘ magnification (Y/Y) Wien ’ 1 ’ 1 ‘ 1 ‘ 1

| Y-object size final, mm | 137 | 8.37 | 2.76 | 2.83
‘ Acceptance, % ‘ 0.5 ‘ 0.5 ‘ 2.5 ‘ 5

| Dispersion W, mm/% | 3 | 3 | 3 | 3

| Acc*DispW, mm | 1.5 | 1.5 | 7.5 | 15

‘ Y-image final, mm ’ 2.0 ’ 8.5 ‘ 8.0 ‘ 15.3
| Y-image / Y-object | 15 | 1.0 | 2.9 | 5.4

2.4. Separation with the Dipole D6

The LISE standard configuration was chosen in order to compare different modes of selection. These experimental settings
(beam, target, wedge, slits) are given below.

Projectile : 40Ar 18+ at 50 MeV/u - Intensity : 1000 enA
Target : Ta Thickness : 100 mg/cm2 (60.241 microns)

Wedge : Al Thickness : 100 mg/cm2 (370.37 microns)
Settings calculated on 36Ar 18+ 18+

Brhol=1.9467 Tm Brho2=1.7067 Tm (B1=0.7487 T B2=0.8521 T)
Wien filter : E=3500.0 kV/m B=417.9618 G Disp=3.725 mm/% Magn=1
D6 : B=0.6069 T Angle=15.87 deg Disp=3.725 mm/%
Acceptances :

Maximum momentum acceptance : +/- 2.50 %

Target : Theta : +/- 17.45 mrad Phi : +/- 17.45 mrad
Wedge : Theta : +/- 20.27 mrad Phi : +/- 6.00 mrad

Slits :

X,Y Slits before target (Collimator) mm +/- : 15 15

X,Y Slits intermediate (Momentum sel.) mm +/- : 45 20

% in Brho +/- : 2.50
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X,Y Slits first focus(Wedge selection) mm +/-
Second image slits (Wien selection) mm +/-
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Table 2.
Mode Selection N° nuclei >, pps 36Ar rate 36Ar rate /
1 First dipole v- A/Q 116 2.4e+6 7.0e+4 2.9%
2 1 + Wedge A25/715 8 1.1e+5 4.6e+4 41.8%
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3 2 + Wien Filter \% 6 7.5e+4 2.8et+4 37.3%

4 3 + D6-dipole A/Q 3 5.7et+4 4.6e+4 80.7%

The advantage of using all 4 selections follows clearly from Table 2. In this case, the purification is 30 times better than after the

first selection, but the 3%Ar rate is lower by only a factor of 1.5. Figures 2 and 3 show vertical spatial distributions in the final
focal plane for selections by the velocity filter and the “fd-system”. The contribution of momentum distribution into the vertical
image due to the existence of non-zero velocity dispersion in the mode with the velocity filter only (Fig.2) makes the image
wider as compared to the “fd-system” that was already discussed in “§2.3. Image size”.

2.5. The program “LISE” for the new spectrometer VAMOS

VAMOS 19 is a collaboration to build a large acceptance spectrometer for identifying products of reactions induced by the
Systeme de Production d'lons Radioactifs et d'Acceleration en Ligne (SPIRAL) facility at the Grand Accelerateur National
d'Tons Lourds (GANIL).

The QQFD-spectrometer VAMOS has the following main properties and characteristics:

o A very large geometrical acceptance, of the order of 100 msr, that is equivalent to an angular acceptance of +160 mrad ;
¢ A nominal dispersion of about 2.5 cm/% at the focal plane ;

¢ A momentum acceptance of the order of £ 5% ;

¢ A velocity filter function.

The new version of “ LISE ” may be useful for estimating transmission and viewing different plots of spatial distributions. The
spectrometer VAMOS is developed for the energy region from 4 to 20 MeV/A where for example the parameterization of
reaction cross-sections does not work. Due to this fact, the program unfortunately cannot be used with all its possibilities. It is
necessary to examine the procedures of reaction mechanisms more accurately. The configuration file allowing one to view
spatial distributions in the focal plane of the spectrometer is given below.

Version 3.4
[general]
File = C:\LISE\config\VAMOS.1lcf
Date = 12-05-1999

Time = 13:41:31

Title = VAMOS
[object]

X Slits before target
Slits before target
Slits intermediate
Slits intermediate

10 (x)mm ; hor.slit width before target to collimate a beam

10 (x)mm ; ver.slit width before target to collimate a beam
100 (+)mm ; hor.slit width at the dispersive focal plane

10 (+)mm ; ver.slit width at the dispersive focal plane

Slits first focus 10 (+)mm ; hor.slit width at the first focal point /after wedge/
Y Slits first focus 10 (+)mm ; ver.slit width at the first focal point /after wedge/
Slits second focus = 1@ (+)mm ; ver.slit width at the second focal point /after Wien/
[acceptances]

Maximal momentum accept = 5 (%)% ; upper limit for the setting of the slits

Theta target acceptance = 160 (+)mrad ; angular target horiz.acceptance

Theta wedge acceptance = 200 (*)mrad ; angular wedge horiz.acceptance

Phi target acceptance = 160 (+)mrad ; angular target vert.acceptance

Phi wedge acceptance = 200 (x)mrad ; angular wedge vert.acceptance

[optics]

X < X <

BX = 1.5 (x)mm ; one-half the horizontal beam extent (x)

BT = 3.3 (x)mrad ; one-half the horizontal beam divergence(x')
BY = 1.5 (x)mm ; one-half the vertical beam extent (y)

BF = 3.3 (x)mrad ; one-half the vertical beam divergence (y')
BD = 0.1 (%)% ; one-half of the momentum spread (dp/p)

Ral = 2.6 m ; Curvature radius of first dipole

Ra2 = 2.003 m ; Curvature radius of second dipole

L target-wedge = @ m ; Object - DispFocPlane

L wedge-detector#l = @ m ; DispFocPlane-AchrFinalPlane
M1X = 1 ; X Magnification target -> wedge

D1X = 10 mm/% ; X dispersion target -> wedge

M1T = 1 ; theta magnific. target -> wedge

D1T = @ mrad/% ; theta dispers. target -> wedge
ThX = 0.1 mrad/mm ; theta/x coef. target -> wedge
M1Y = 1 ; Y Magnification target -> wedge

PhY = 0.1 mrad/mm ; fi/y coef. target -> wedge
M1P = 1 ; fi magnificat. target -> wedge

M2X = 1 ; X Magnification wedge -> focal

D2X = -10 mm/% ; X dispersion wedge -> focal

M2T = 1 ; theta magnific. wedge -> focal

D2T = -1 mrad/% ; theta dispers. wedge -> focal
T2X = 0.1 mrad/mm ; theta/x coef. wedge -> focal
M2Y = 1 ; Y Magnification wedge -> focal

P2Y = 0.1 mrad/mm ; fi/y coef. wedge -> focal

M2P = 1 ; fi magnificat. wedge -> focal

Angle = @ mrad ; beam respect to the spectrometer axis

[wien_filter]
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Wien filter = Enabled ; Disabled & Enabled
E_F 2000 kV/m ; electric field

B_F 478.861416 G ; magnetic field

DiC 1.3856e-3 mm/% ; dispersion coefficient
LenE = 1 m ; effective electric length

LenB = 1 m ; effective magnetic length

Red = 1 ; Real/Red field

Mag = 1 ; Magnification

3. New features of the version 3.4

3.1. Physical calculator

Very often it is necessary for the User to perform a fast transformation from one physical value to another while working
with the program. The dialog “GOODIES” allows one to obtain a calculated correlated value only for a given Bp -value
obtained for a setting fragment. However, what if the User needs to know (for example) a range in some material for an energy
unconnected with the given settings? The new version of the code “LISE” allows one to solve this problem. The new dialog
“Physical calculator” permits one to perform calculations of correlated values immediately and independently of calculations for
a setting fragment. By clicking on any radio button, the User may choose the respective form to enter a physical value in order to
obtain other correlated values. For example, User may input the Bp -value for 3%Ar (see Fig.4) and get all correlated values
including the range in the given material and the energy loss for the chosen thickness, or, by typing the residual energy of 22Al
after the material (Si 100 mg/cm? in Fig.4), one can recalculate initial energy of a nucleus before the material and other
correlated values as shown in Fig.5.

Physical Calculator 3 |l Physical Calculator | X|

A Element Z Ot Table of NucIidesI A Element Z Ot Table ofNucIides'
| G | | | | 22 IAI |13 |13
i L L I Stable | Beta+ decay
Energy ¢ [ 47115 Mev/a  Rangeto (‘| 90241 mglem? Energy Mev/s  Rangeto mg/cm2
Brho & [ 20000 Tm Si [ 129791 (Em Brtho Tm Si || 2671.58 | pm
TKE MeV TKE MeV
37.104 E Rest I B MeVia
Velocity 91957 cm/ns SO HRa Velocity ¢ | 107555 cméns neigy et d ®
Beta Energy Loss 36048 MeV Beta Energy Loss 13970 MeV
after/into. 41| [~S7 100 mg/en? after/into 4|["Si 100 mg/en?
Pint | Help | Quit | Pint | Help | uit |
Fig.4,5

The eight correlated values of a nucleus (which is entered in the upper part of the dialog) are included in the “Physical
calculator™:

Energy [MeV per nucleon] ;

Bp -value [Tm)] (for calculations, Qt - the ionic charge - is used) ;
TKE is the Total Kinetic Energy [MeV] ;

Velocity [cm/ns] and beta ;

e Range in the specific material chosen by User. The range may be entered in mg/cm? as well as in microns.
Residual energy of a nucleus [MeV per nucleon] after the material defined by the User. For convenience the energy loss
[MeV] in the material is shown in the static window below.

Correlated values of time of flight and Wien magnetic field may possibly also be added to the Physical calculator. All this makes
the Physical Calculator a powerful tool, allowing the User to quickly obtain a physical value of interest from other correlated
values.

3.2. Configuration file
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Two types of files were used in the previous version of the File

program: LISE files (extension LIZ) and Result files Configuration
(extension RES). The settings data could be recovered only Save

from LISE files. If the User wanted to repeat old settings for View

a new file, it was first necessary to find the corresponding -
LISE file with the same setup configuration and then save it with a new name. In the new version there is an additional
possibility to save and extract settings to and from a new kind of file called the Configuration file. The User has access to these
files via the menu “File -> Configuration”. These files contain only some sections from a standard LISE file :

e general (creation date, description); Open

e object (size of all slits);  y=— = O [ e
> Look in: | {3 config = £ B

e acceptances; I _l @I —I

|=#] lise2000-bis.lcf

@ LISE-standard.lcf

El sissi_AlphaDegrader_alphadrete. Icf
@ SISSI_AlphaDegrader_LiseDE.Icf
] 51551_LISE degrader_LIDEdE.Icf

e optics;
Wien-filter.

Configuration files (file extension “LCF”) are placed by
default in the directory “CONFIG” which is a subdirectory
of the LISE directory (see Fig.6). The listing of the
configuration file “VAMOS.Icf” has already been included

in the section "2.5. The program “LISE” for the new
prog File name: | | Open I

spectrometer VAMOS".
Files of type: ILise Configurations (% lcf) ZI Cancel |
characteristics of setups given in Ref.11-10)_ different

setups for the LISE program were put into configuration files. User may find these configuration files in the distributed version
“lise34.zip” :

On the basis of the optical matrices and physical

o LISEstandard.lcf - the standard spectrometer LISE configuration. A target is placed into the LISE target box ;

o LISE2000-bis.Icf - the new project of the spectrometer LISE with large angular and momentum acceptances, maximal
magnetic rigidity of the second dipole is 4.3 Tm . A target is placed into the LISE target box ;

o SISSI AlphaDegrader AlphaArete.lcf - a target is placed into the device SISSI, an achromatic degrader in the dispersive
focal plane of the spectrometer Alpha. The final focus plane is “ARETE” (the Alpha spectrometer outlet) ;

e SISSI AlphaDegrader LISEd6.1cf - a target is placed into the device SISSI, an achromatic degrader in the dispersive
focal plane of the spectrometer Alpha. The final focus plane is the hall “D6” of the spectrometer LISE ;

e SISSI LISEdegrader LISEd6.lcf - a target is placed into the device SISSI, an achromatic degrader in the dispersive focal
plane of the spectrometer LISE. The final focus plane is the hall “D6” of the spectrometer LISE,

o VAMOS.Icf - this configuration has been already discussed in “§2.5. The program “LISE” for the new spectrometer
VAMOS”.

Using this new feature, the User may call these configuration files to estimate which setup is more favorable for given
experimental settings (beam, target, degrader, wedge, Bp -values and setting fragments). The experiment parameters will not be
changed, while the acceptances, optics, slits, and velocity-filter coefficients will be taken from a configuration file.

3.3. Angle for Thickness

3/31/2026, 4:04 PM
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[EITID]M] A physicist may vary the target thickness by changing the angle of the target placed in the target box of
the SISSI device or the LISE spectrometer. Sometimes it is necessary to calculate and enter the value of
the angle in the experiment. In the new version of the code, the User can change the angle of a target (wedge, degrader,
materials). There is a possibility to calculate each of the three values from the other two known ones : Effective thickness,
thickness at 0 degrees, or turning angle (see Fig.7). For example, if User knows the effective target thickness and the thickness at
0 degrees he can simply click on the button “Calculate Angle ” to get the angle value as shown in Fig.7. User may input the

material thickness using two dimensions : mg/cm? or microns.
3.4. List of recently used files

To open a document recently used by the User, it is necessary to click its name ' Eile
at the bottom of the File menu, where the list of recently used documents is
placed. 1 Chuser\OLE G winliseA\FILESY364 ILisenodeqr.liz
2 &:A\3BAr_224lLisenodear.liz

3 Chuser\OLEGh\winlise\FILES\t liz

4 C:\user\OLE Ghwinlise\FILES\dE_without_\Wien.liz

5 Chuser\OLE Ghwinlise\FILES\dE.liz

B C:\user\OLEGhwinlise\FILES\bb_al22_a.liz

3.5. Calculation of Q-ground value for binary reaction

In the new version, the User may see the Q-value of a reaction at the bottom of the window * Statistics ” (this window appears
when the User clicks on an isotope of interest in the table of nuclides with the right button of the mouse). The Q-value is
calculated from the assumption that the reaction has two nuclei as a result. The first nucleus is the nucleus chosen by User, the
second one is calculated as the residual from “ Projectile + Target - Fragment of Interest ”. Therefore, the Q-value is estimated
as:

0= (MEprojectile+ MEtarget) - (MEfragment + MEjesidual) > [13]

where ME is the mass excess from the database built into the program. The database uses the recommended values proposed by
G.Audi and A.H.Wapstra 7).
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\ statistics 22Al O] x|

2241 Beta+ decay (Z=13, H=9) ﬂ

ot 13

Qu 13
Energy after 2-nd dipole. HeV-/4 48 .08
00 Angular transmission (%) 6.29%
01 Brho transmission (%) 10.40%
02 Wedge transmission (%) 86.17%
03 Wien transmission (%) 99 .78%
04 Total transmission (%) 0.50%
05 Cross section (mb) 4. 9e-04
06 Qtarget ratio (%) 100.00%
07 Quwedge ratio (%) 100.00%
08 Production rate (pps) 3. 1le+01
09 Sum of charge states (pps) 3.1e+01
10 ¥ Brho transmission (%) 88 .48%
11 ¥ Wedge transmission (%) 99.92%
12 No 'dead' target (%) 100.00%
13 ¥-target ang.transmis. (%) 9.37%
14 Y-target ang.transmis. (%) 9.37%
15 X-wedge ang.transmis. (%) 73.98%
16 Y-wedge ang.transmis. (%) 60.93%
17 i-target slits (%) 100.00%
18 Y-target slits (%) 100.00%
DataBase index 2213
Mass excess, [HeV] 18.1830
Binding energy 149 . 2160
Beta—-decay energy -13.9820
S(2n) *
S(2p) 3.2400
Q{alpha) -9.5600
Si{n) 16.0080
Si{p) 0.0180
T1_2 70 m=
Q-reaction (b+t —> f1+£f2) —-40.40 HeV é."

Fig.§8.

3.6. Chromatic mode (Dispersion = 0)

g Since its first version, the program has been adapted to operate only in the achromatic mode. The focal plane of the second
section being achromatic, there is no momentum dependence of the final horizontal position (as well as vertical). In the new
version, the assumption that the full momentum dispersion is not equal to 0 has been included. The User may observe this
assumption on the Wedge image (X) plot in the first focal plane. This assumption is fulfilled because the selection by the
velocity filter and the dipole “D6” takes place in the Y-plane. Using this new mode, the User may visualize the images and
obtain a transmission not only for the “ideal” case of an achromatic spectrometer.

The code calculates full momentum and angular dispersions on the basis of the two transport matrices input into the program for
both parts of the spectrometer, as follows:

L= (Z 2] +|E] pemsoe], na4

0)e 0 Jilx): (8)s

91 -=1(2] +|9]| (2] +|¢ [mrad /%) .[15]
0)e L0 Jilx) \8)il0): |9);

The code always accepts the angular achromatism at the second focal point, though User may observe in the dialog “Optics” a
nonzero value of the full angular dispersion from Equation 15. User may see the calculated value of the full momentum
dispersion in the dialog “Optics” as well as in the StatusBar at the bottom of the code screen.

(ACMOmdbm

Dispersion X [full) I 97000  mm/%

Figures 9 and 10 demonstrate the new possibility. Three distributions on [TnotAchiom
the Wedge selection plot are presented in Fig.9 for the achromatic case as it
was in previous versions. The distributions of the same nuclei as in Fig.9 are shown in Fig.10, but for this case the global
momentum dispersion is equal to 9.7 mm/%. It is clearly apparent that, in the chromatic case, the distributions are wider and the

transmission is not equal to 100%. Peak shifts in the distributions of 3337Ar as well as shapes of these distributions are
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explained by a non-optimal Bp value for these nuclei, as demonstrated for the 30Ar isotope (see the Brho Selection plot in
Fig.11). The low energy part of the 37Ar distribution and the high energy part of the 33Ar distribution have been cut by the

momentum slits. Their momentum distributions are more similar to a triangle, whereas the 3°Ar distribution presents itself as a
symmetrically cut Gaussian. The convolution of these distributions with the object distributions gives the result shown in Fig.10.

\
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g " Ar100.0% ‘
2 Dispesion=0 mmi%
1e+d | FAr100.0% ‘
i ,-’f’ x."‘-\\.
.y 5| / k
£ / Wedge's ectlmm plot
@ /| a0pc 50.0 MeVIA + T 100.00 miyem2. Settngs on JActas 13
g 2 Dégrader:  D.0mgiem?2 Wedge: ‘00'mg/iém2 Sits first image: & 10.0 mm
= Gh;éal Spectrometer Dispersion 0.000 mr'npx Dispers*)n of 2-nd part 44.300 mm/%
Fig.09. © 1e+3| / )
= : f \
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gl |
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\ \
e8] Brho selection plot ‘ WAL35.0%
B 40fe 50.0 Me\¥A + Ta 100.00 mgicm2
5 Degader: 0.0 mgiem2; ‘edge: 0.0 mglem2
| Settings on 26418+ 13+ Brin acceptance | £ 2.
=] i P
£
[
-
S 1e+5|
(= E
2 "
g 5|
. u §
Fig.11. 3
- 2|
1e+d |-
5
2 e
174 1.78 1.82 i g 194

Brho (Tm)

4. Development
4.1. Results file

The Results file has not been changed since its DOS version 2.5, and consequently, in versions 3.0-3.3.05, it does not reflect all
parameters needed by the User (“D6”-dipole parameters, applied methods of the cross-section parameterization and the ionic
charge state distributions, target angle). In the new version the Results file has taken on a more readable form, and all values
needed for further work of User with this file have been included.

LISE CALCULATIONS Version 3.4

File : C:\user\OLEG\winlise\FILES\36Ar_22AlLisenodegr.liz
Date : 5/19/1999 Time : 9:13:01

Title : 22A1

Projectile : 36Ar 18+ at 94.4 MeV/u - Intensity : 1000 enA
Target : Be Thickness : 537.95 mg/cm2 (2907.84 microns)
Wedge : Be Thickness : 196.47 mg/cm2 (1062 microns)
Material (s)

#1 : Si Thickness : 69.9 mg/cm2 (300 microns)

#2 : Si Thickness : 69.9 mg/cm2 (300 microns)

#4 : Si Thickness : 116.5 mg/cm2 (500 microns)

#5 : Si Thickness : 116.5 mg/cm2 (500 microns)

#6 : Si Thickness : 1398 mg/cm2 (6000 microns)

Settings calculated on 22A1 13+ 13+

Brhol=1.9530 Tm Brho2=1.7100 Tm (B1=0.7512 T B2=0.8537 T)
Wien filter : E=3500.0 kV/m B=331.8000 G Disp=3.184 mm/% Magn=1
D6 : B=0.5354 T Angle=13.97 deg Disp=3.185 mm/%

Mechanism: Vopt/Vbeam=1.000 Sigma0=90.0 MeV/c SigmaD=200.0 MeV/c
Methods: Cross Section=0 Charge states=0

Acceptances :

Maximum momentum acceptance : +/- 2.50 %

Target : Theta : +/- 17.45 mrad Phi : +/- 17.45 mrad

Wedge : Theta : +/- 20.26 mrad Phi : +/- 6.00 mrad

Slits :

X,Y Slits before target (Collimator) mm +/- : 15 15

X,Y Slits intermediate (Momentum sel.) mm +/- : 8.6 10

% in Brho +/- : 0.50

X,Y Slits first focus(Wedge selection) mm +/- : 7 10

Second image slits (Wien selection) mm +/- : 5

Beam emittance (+/-): 1.5 mm 3.3 mrad 1.5 mm 3.3 mrad 0.1 %
Beam angle on target : 0 mrad

OPTICS ([mm], [mrad]):

Target - DispFocalPlane (Wedge) DispFocalPlane (Wedge)-First image
-0.783 * * * 17.3 -2.5607 * * * 44.3

0.267 -1.284 * * 3.51 0.4 -0.389 * * -5.56

koK =4.26 * * x * -0.,432 * *

* * -0.858 -0.273 * * * -0.32 -2.4 *

TRANSMISSION AND RATE CALCULATIONS

A Z |Qt |Qw | Ang. | Brho |Wedge |WienD6|Y&C&DT| Total | Cross | Rate | Qt | Qw

| | |Trans.|Trans.|Trans.|Trans.|Trans.| Trans.|Section| | |

b s 1 (%) | (%) | (%) | (%) | (%) | (mb) | (pps) | (%) | (%

***** [ ===l === | | | Bl Bttt e ittt Rttt
238i| | | 6.534] 4.692| 85.05| 2.641| 88.41| 0.0061]3.3e-06| 0.0025]

22A11 | | 6.291| 10.40| 86.17| 99.78| 88.41| 0.4972[0.00049| 31|

21Mgl| | | 6.018| 4.905| 84.89| 0.921| 88.41| 0.0020| 0.029| 7.5]|
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ALMOST : 38 pps

4.2. New parameterization

".: The code used three in-built parameterizations of cross-sections based on EPAX 4). The new parameterization EPAX 2.13
has been kindly presented by B.Blank and K.Summerer for the new LISE-version. This new approximation shows very good
agreement in cross-section estimation for proton-rich fragments, while for the super-neutron-rich isotopes located far from the
beam !2) the discrepancy appears (see Fig.12), as in the previous parameterization, but on the other side.

1e+3 , ” .
: Cross sections Eapto

1e+2 |

1e+1 ’ ¥ +Ta-> N=2D

1e+0 |,

AN

experimental values PLB409(1997)64

Cross Section, mb

Cross Section calculations |3 - EP4X 2.13 : K.Summerer et B.Blank (1939)

3
0 - EP&X from <<LISE>> [D.Bazin)
1
2

- original EPAX: K.Summerer et al. Phys.Rev.C42(1990)2546
- 36 Phys.Lett B409(1937164

The User may choose the new parameterization to perform calculations via the menu
“Options->Production Mechanism”.

4.3. Trigonometric function of the in-built calculator

Fig.13. AERE, M= B3

The trigonometric functions (sin, cos, tan, arcsin, arccos) have been added in the

in-built calculator. The User has also got an opportunity to choose units (degrees or
radians) for trigonometric calculations (see Fig.13).

4.4. Three points interpolation for the energy loss and range subroutines

Fig.14.
In the previous version the energy loss and range subroutines
used the linear interpolation to get a result from the tabulated
values. The new code version describes the tabulated values by a
second order polynomial using three points (see Fig.14). This
allows one to smooth some distributions (for example the Range
distribution in materials).

5. Plots

5.1. image after Wedge & D6 (one-dimensional plot) and dE - Y image (after wedge & D6)
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800

700

Energy loss (MeV) Idetector #4/

5.2. dE-dE plot

I Two kinds of plots have been

created to visualize the Y-image
distribution in the final focus plane after
the velocity filter and the dipole “D6”.
The one-dimensional plot (left menu)
has been already presented in Fig.2 and
3.

The two-dimensional plot (right menu)
dE-Y (Energy Loss versus Y-image) is
presented in Fig.15.

https://lise.frib.msu.edu/3_4/lise 3 4.html

T

=

dE - Y after Wien & D6
i ©40Ar7B9 MeV/A + Be (129000 mgiemz) SR
‘Settings on 240 8+, Degrader (0.0 mg/cm3); Wedge: Be 2.5 mg/c

)

Image 2 (after Wien & D6) (mm)
Fig.16.
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Fig.17.

5.3. dE-X plot
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[Plot Help
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T

EE - T 40Ar 16.9 MeV/A + Be (129000 mg/em?)

Settings on 240 8+, clfegrader
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e

0.0 mgfcm2), Wedge: Be 82.5 mg/cmg)
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5.4. Plot of Q-ground values
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Xposition in the First Focal Plane, mm

Fig.18.
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Q-ground systematics (P+T -= F1+F2)
@ Help Bpe + Be > Z=13
Plot dE-TOF
Plot Z:4/Q 5|
Plot dE-E
Plot dE-dE
Plot dE %
Plot dE-Y' after ‘Wien and DB

(L]

15 |-

Angular distributions

Brho selection plot

Wedge selection plot
Wien and DE selection plot
Y selection plots

Qground, MeV

25|

Range distributions 35

Charge distributions

Cross jon distributions
3-ground distributions 45
22 23 24 25 26 27 28 20 30 31

Options A
Fig.19.

5.5. Realistic image of peaks

8 Two-dimensional plots in standard mode are drawn only by one color corresponding to their intensity. The width of the peak
is equal to its distribution FWHM. “Realistic” mode for peak drawing uses some colors depending on the distance between the
peak center and a given point inside the peak (width £ 2c ). Example of the plot drawn in the “realistic” mode is presented in
Fig.17.

5.6. Gray and Color Palettes for two-dimensional plots

' The User does not always have the possibility of printing two-dimensional plots on color printers. Therefore, a button has
been added to switch the plot palettes in order to reproduce the peak intensity for printing.

6. Bugs

6.1. The thickness dialog - density

Previously, it was impossible to enter a float value into the density window of the thickness dialog. This has been corrected.
6.2. The dialog “Calibrations”

After inputting a new nucleus in the calibrations dialog, the range was not recalculated. This has been corrected.

6.3. Adaptation the code to the PC emulator on Mac

Cross-section calculations were performed incorrectly on Mac under the PC emulator due to some discrepancy in the C function
“pow(x,y)” between these system platforms (?). The function pow(x,y) has been changed in the code by redefinition #define

pow(x,y) exp((y) log(x))
6.4. Negative dispersion

The negative momentum dispersion caused the program to crash. This has been corrected, and the User may use negative
momentum dispersion.

6.5. After reading of a LISE-file the program did not calculate magnetic field

The conjugate values (Bp and B) are immediately recalculated when User changes the Bp-values or the B(magnetic field)-values
using the dipoles dialog or when the program calculates these values. When the User read a LISE file, the Bp values were
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entered into the code without recalculation of the magnetic field. This has been corrected.
6.6. Distributions

Some bugs provoking crashes of the program have been corrected.
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